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1 Introduction

aim of this technical note

This document describes how to start and stop Tobii Pro eye trackers in 
The Observer XT and how to import the eye tracking data into the 
observation. This document describes the use of the Tobii Pro X2 Eye 
Trackers. These are stationary eye trackers that are positioned below a 
computer monitor. They are controlled with the analysis software Tobii 
Pro Lab or Tobii Pro Studio. 

This technical note describes both Tobii Pro Lab and Tobii Pro Studio. 
When instructions are identical, both applications are referred to as 
Tobii Pro software. Where needed, separate instructions for the two 
applications are given. 

system used

Computer

All software was tested on our standard test platform, which is a Dell 
Precision T5810 desktop computer. 

 Processor: Intel Xeon E5-1620 v3, at 3.50 GHz.

 RAM Memory: 8 GB.

 Operating system: Windows 10 64 bit.

The Observer XT and the Tobii Pro software were installed on two 
separate computers. 

software

On the The Observer XT computer

 The Observer XT 14.2.
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 N-Linx Server version 1.0, for communication between The Observer 
XT and other applications.

note  The N-Linx Server can also be installed on a third computer, 
connected with The Observer XT computer and the computer with 
Tobii Pro software.

On the computer with Tobii Pro software

 We tested:
- Tobii Pro X2-30 Eye tracker with Tobii Pro Lab 1.98.15089. 
- Tobii Pro X2-60 Eye tracker with Tobii Pro Studio 3.4.7.

note  If you have another eye tracker than the ones tested by 
Noldus IT, check thoroughly that the solution described in this note 
works.

 N-Linx Agent version 1.2, for communication between The Observer 
XT and Tobii Pro Studio or Tobii Pro Lab.

 Tobii Pro Studio and Lab plugin installed on the computer with 
Tobii Pro Studio or Tobii Pro Lab.

note  You can install this component when you install N-Linx 
Agent.

 Noldus Tobii Studio File Converter 3, to convert Areas of Interest 
(AOI) data from the Tobii Pro software. For other data types you do 
not need a file converter. 
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Notes

 The communication system N-Linx Server + N-Linx Agent + Tobii Pro 
Studio and Lab plugin takes care of automatic start and stop of data 
co-acquisition with Tobii Pro software when you operate The 
Observer XT. It does not transfer the data from Tobii Pro software to 
The Observer XT, or synchronize the data with the event log. For 
this, you must export the data files from the Tobii Pro software, 
import them into The Observer XT, and synchronize manually with 
the event log.

 The N-Linx Server adds the possibility to extend the solution with 
other N-Linx enabled software and custom development (N-Linx 
SDK). Contact Noldus for details.

import profiles 

Import profiles for data from Tobii Pro Lab

To import data from Tobii Pro Lab into The Observer XT, import profiles 
are available. These can be downloaded from https://
www.noldus.com/restricted/observer-xt-14-other-downloads. 

Download the zip-file and extract it to a temporary folder. Copy the 
profile to C:\ProgramData\Noldus\Common\Profiles on your 
computer with The Observer XT. Copy both the folder and the file.

Import profiles for data from Tobii Pro Studio

To import Tobii Pro Studio data, a number of import profiles are 
available. These are installed automatically when you install The 
Observer XT. For the import procedures, see page 26 and page 37 for 
non-AOI data and AOI data, respectively.

for more information

About The Observer XT

 The Observer XT Help.
Introduction
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- For visualizing data: see Visualize Data.
- For calculating statistics: see Calculate Statistics.

 Quick Start Guide - The Observer XT.

 The Observer XT sample project, which you can find on the 
installation USB stick, in the folder Sample Projects/Human sample 
project. Other sample projects can be downloaded from https://
www.noldus.com/downloads. To access this page you need to 
register and login first.

 The Noldus Customer support center https://www.noldus.com/
support-center. The web page of the Noldus Customer support 
center also contains the customer support database with questions 
asked by The Observer XT users and answers from the help desk.

About N-Linx

 The Reference Manual - N-Linx, which you can find on The Observer 
XT installation USB stick.

About Tobii Pro Software

 The Tobii Pro Lab or Tobii Pro Studio User Manual.
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2 Computer configuration

main steps

 The Observer XT computer and the computer with Tobii Pro 
software must be connected to a local network, and both must 
have a fixed IP address that fall in the same range. For example 
191.168.0.50 and 191.168.0.51. See set ip address below.

 Install N-Linx Server on computer with The Observer XT, or on a 
third computer that is connected to both The Observer XT and the 
Tobii Pro computer. See page 12.

 Install N-Linx Agent together with the plugin Tobii Pro Studio and 
Lab on the computer with Tobii Pro software. See page 13.

 It can be useful to create a shared folder on the Tobii Pro software 
computer where gaze replay videos and exported data are stored. 
This way you have always quick access to the eye tracking video and 
data from The Observer XT computer. See page 14.

set ip address

Connect both computers with an Ethernet cable. Then give both 
computers a fixed IP address that falls in the same range. To do so, 
follow the procedure below for both computers:

1. Open the Control Panel and select Network and Sharing Center.

2. Click Change adapter settings on the left side of your window.
Computer configuration



3. Right-click the Local Area Connection and click Properties. If your 
computer has more than one Local Area Connection, choose the one 
with which the computer is connected to the other one. To check 
which one this is, remove the cable. The LAN connection that gets 
the disconnected symbol is the correct one.

4. Select Internet Protocol Version 4 (TCP/IPv4) and click Properties.

5. Click Use the following IP address. 

6. In the IP address field, enter the same first three numbers for both 
computers and a fourth number that is differs on both computers. 

7. Enter the number 255.255.255.0 in the Subnet mask field on both 
computers. Leave the other fields empty. 
Computer configuration 11
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8.  Click OK and close the Control Panel. 

install n-linx server

important  Install this piece of software on the The Observer XT 
computer, or on a computer connected with both the computer with 
The Observer XT and the one with Tobii pro Software.

1. Insert The Observer XT installation USB stick in one of the PC’s USB 
ports. 

2. Browse to Drivers and Tools\N-Linx Server.

3. Double-click N-Linx Server Setup.exe.

4. Next to Installation type choose Standard, unless you want to 
change the program location.

5. Follow the instructions on your screen.
Computer configuration



install n-linx agent

important  Install this piece of software on the computer with Tobii 
Pro software.

1. Insert The Observer XT installation USB stick in one of the USB 
ports of the computer on which the Tobii Pro software is installed. 
Browse to Drivers and Tools\N-Linx Agent. 

2. Double-click N-Linx Agent Setup.exe.

3. Next to Installation type choose Standard, unless you want to 
change the program location (C:\Program Files\Noldus\N-Linx 
Agent 1).

4. In the Plugins field, select Tobii Pro Studio and Lab, and click Next. 

5. Accept the End-User License Agreement, click Install and follow the 
instructions on your screen.

6. If the N-Linx Agent user interface does not open after installation, at 
the bottom-left corner of the screen, on the system tray, click the 
arrow icon and double-click the N-Linx Agent icon.

7. In the N-Linx Agent user interface, next to N-Linx Server Address, 
enter the IP address of the computer where N-Linx Server is 
installed. This IP address must be fixed.
Computer configuration 13
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If The Observer XT and N-Linx Server are installed on the same 
computer, enter localhost.

tip  You can also enter the Computer name instead of the IP 
address. To find the Computer name of the computer where N-Linx 
Server is installed, on that computer open the Control Panel and 
choose System. Locate Computer name.

8. Click Connect. If connection is established, the message at the 
bottom of the N-Linx window says Connected.

Notes

If N-Linx Agent is already connected, the icon in the taskbar looks like 
this:

create a shared folder 

Share the folder with eye tracking data and videos, so that it can be 
accessed from the computer with The Observer XT. This is useful when 
you import eye tracking data and videos into The Observer XT.

On the computer with Tobii Pro software

1. Right-click the folder where the Tobii Pro exported data and videos 
are going to be stored, and select Share with and then Specific 
People.

2. Click the arrow next to Add and select Everyone and then click Add.
Computer configuration



 

3. Select Read/Write as Permission level and click Share.

On both computers

1. Open File Explorer and then This PC.

2. Click the Map network drive icon.

3. Choose a name for the drive and browse to the shared folder. Choose 
the same name on both computers. Then click Finish.
Computer configuration 15
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3 Workflow

main steps

1. Prepare The Observer XT (page 17) to make sure that the data 
collected can be started and stopped with The Observer XT.

2. Record data with Tobii Pro Lab (page 20) or Tobii Pro Studio (page 23).

3. Export eye tracking data like fixations and saccades from Tobii Pro 
Lab (page 26) or Tobii Pro Studio (page 27). 

4. Import Tobii Pro data in The Observer XT (page 29).

5. Import the Gaze replay video in The Observer XT (page 36). 

6. Optionally, export Area of Interest data (AOI) from Tobii Pro Lab 
(page 37) or Tobii Pro Studio (page 38). Next, use the Noldus Tobii 
Studio File Converter 3.0 to make the data files compatible with The 
Observer XT (page 39) and import those files into The Observer XT 
(page 43).

important terms

You define a project both in The Observer XT and the Tobii Pro software, 
however this term represents different things in the two programs. 

 In Tobii Pro Lab, a project can contain one or more recordings. 

 In Tobii Pro Studio, a project can contain different tests, each of 
them containing one or more recordings.

 In The Observer XT, a project contains observations, which are the 
equivalent of the recordings in the Tobii Pro software. 

However, you can import data from one test/study, or multiple tests/
studies into one project of The Observer XT.
Workflow



4 Prepare The Observer XT

aim

To set The Observer XT to start and stop eye tracking with the Tobii Pro 
software.

If you ordered a set-up from Noldus IT, these settings have already been 
made. Then, continue with: 

 Record with Tobii Pro Lab on page 20 or

 Record with Tobii Pro Studio on page 23.

prerequisites

 N-Linx Agent and the plugin Tobii Pro Studio and Lab are installed 
on the computer with Tobii Pro software.

 N-Linx Server is installed on the The Observer XT computer or on a 
third computer connected to the The Observer XT computer and 
the computer with Tobii Pro software computer.

 The Observer XT is opened and you have created a project.

procedure

Connect The Observer XT to N-Linx Server

Follow this procedure just once. The settings are also valid for any new 
The Observer XT project that you create.

1. In The Observer XT, choose File > Preferences.

2. Click N-Linx Settings on the left.

3. Select Use N-Linx Server to connect with other applications.
Prepare The Observer XT 17
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4. Next to N-Linx Server address, enter the computer name of the 
computer with N-Linx Server. Leave the default entry localhost if The 
Observer XT and N-Linx Server are installed on the same computer.

tip  To find the Computer name of the computer with N-Linx Server, 
open the Control Panel and choose System. Locate Computer name 
(not Full Computer name).

5. Make sure the N-Linx Server port is 5672. 

Ask your system administrator for assistance with choosing 
another port if port 5672 is used by another program.

6. Click Test connection, and check that the Status changes to 
Connected.

If connection fails, review all the settings under Computer 
configuration (page 10).

Project Setup

Follow these steps for each new The Observer XT project you create to 
work together with the Tobii Pro system.

1. Choose Setup > Project Setup.

2. Under Observation Source select Live Observation.

In the next steps you specify that The Observer XT communicates 
with the Tobii Pro Studio and Lab plugin, which should be installed 
together with N-Linx Agent on the computer with Tobii Pro 
software.

3. In the Devices window, check that Tobii Pro [computer name] is 
selected.
Prepare The Observer XT



If you do not see this item, it is likely that N-Linx Agent is not 
installed, or that the plugin Tobii Pro Studio and Lab was not 
selected when you installed N-Linx Agent. Re-run the N-Linx Agent 
installer file, and select Modify and choose Tobii Pro Studio and 
Lab. See page 13.

4. Click OK.

Coding Scheme

To annotate your test participant’s behavior, create a Coding Scheme. 
See The Observer XT Help for more information. 
Prepare The Observer XT 19
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5 Record with Tobii Pro Lab

aim

To design a test in Tobii Pro Lab and start and stop eye tracking 
acquisition with The Observer XT. 

prerequisite

You set up The Observer XT, following the procedure on page 17.

procedure

In Tobii Pro Lab

1. Create a new Tobii Pro Lab project, or open an existing one. In case 
of a new project, choose Screen as Project type.

2. Open the Design tab.

3. Press the Add stimulus button on toolbar on the top and browse to 
the stimulus to display. Set its properties, for example the display 
duration, in the Properties pane on the right. Add more stimuli, if 
needed.

4. You are now ready to start your observation in The Observer XT.

In The Observer XT

5. Create a new observation. To do so, click Observations in the Project 
Explorer, then Create a new observation.

6. Name the observation, then click OK.

In Tobii Pro Lab

7. Let the participant take place behind the monitor with the eye 
tracker.
Record with Tobii Pro Lab



8. Open the Record tab. 

important  Do not click the Start Recording button. Start the recording 
by starting an observation in The Observer XT (see below).

In The Observer XT

9. To start the test, click the Start observation button.

If the Enter Independent Variable Values window opens on the 
screen of The Observer XT, enter the independent variable values 
for that observation and click OK.

In Tobii Pro Lab

10.The calibration starts. Check that the test participant’s eyes are 
visible as two white circles in the center box of the drawing that 
appears on your screen. If not, change his/her position relative to 
the monitor (lower or raise the chair or let the test participant sit 
closer or further away from the monitor).

11. Click Start calibration to start the calibration and let the test 
participant follow the symbol moving on the screen. When the 
calibration is ready, a plot with the calibration results appears on the 
test leader monitor. 

12. Check whether the calibration is good, that is, whether the distance 
between the gaze points and the positions of the calibration symbol 
is acceptable. If so, click Accept. 

13. The stimuli are now presented. Let the participant carry out the 
tasks assigned.

In The Observer XT

14. Optionally, score the behaviors with keys on your keyboard.

15. To stop the test, click the Stop observation button in The Observer 
XT.
Record with Tobii Pro Lab 21
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Eye tracking now stops automatically. 

notes

 Eye tracking also stops when the test you designed in Tobii Pro 
Studio ends before you pressed the Stop observation button in The 
Observer XT. 

 If the computer with the Tobii Pro software is restarted, you must 
restart The Observer XT as well. Otherwise starting acquisition 
with the Tobii Pro software will not work. 

 If the computers with The Observer XT and the Tobii Pro software 
are restarted, it may take some time before the Tobii Pro plugin 
starts when you create the first observation. If you start an 
observation in The Observer XT before the plugin is fully running, 
acquisition with the Tobii Pro software does not start. If you notice 
this, create and start a second observation. Acquisition with the 
Tobii Pro software will now start. 

more information

For more information on how to design a test in Tobii Pro Lab, see the 
Tobii Pro Lab user manual.
Record with Tobii Pro Lab



6 Record with Tobii Pro Studio

aim

To design a test in Tobii Pro Studio and control recording with The 
Observer XT. 

prerequisite

You set up The Observer XT, following the procedure on page 17.

procedure

In Tobii Pro Studio

1. Create a new project, or open an existing one.

2. Create a new test.

3. From the toolbar on the top, choose the stimulus to test and set its 
properties, for example how long it should be displayed on the test 
screen. Add more stimuli, if needed.

4. You are now ready to start your observation in The Observer XT.

In The Observer XT

5. Create a new observation. To do so, click Observations in the Project 
Explorer, then Create a new observation.

6. Name the observation, then click OK.

In Tobii Pro Studio

7. Let the participant take place behind the monitor with the eye 
tracker.

8. Click Start Recording. 
Record with Tobii Pro Studio 23
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9. optional  Enter the name of the test participant, and click Continue.

10.The Calibration screen opens. Check that the test participant’s eyes 
are visible as two white oval shapes in the Calibration screen. If not, 
change his/her position relative to the monitor (lower or raise the 
chair or let the test participant sit closer or further away from the 
monitor).

11. Click Start to start the calibration and let the test participant follow 
the symbol moving on the screen. When the calibration is ready, the 
Calibration window appears. This window shows at what points on 
the screen the test participant looked and the positions of the 
calibration symbol.

12. Check whether the calibration is good, that is, whether the distance 
between the gaze points and the positions of the calibration symbol 
is acceptable. If so, click Accept. A new screen appears. Fill in the 
name of the recording.

important  At this stage, do not click the Start Recording button in 
Tobii Pro Studio. The system is configured to start recording 
automatically from The Observer XT.

In The Observer XT

13. To start the test, click the Start observation button in The Observer 
XT.

If the Enter Independent Variable Values window opens on the 
screen of The Observer XT, enter the independent variable values 
for that observation and click OK.

Eye tracking now starts automatically. 

14. Let the participant carry out the tasks assigned.

15. Optionally, score the behaviors with keys on your keyboard.

16. To stop the test, click the Stop observation button in The Observer 
XT.
Record with Tobii Pro Studio



Eye tracking now stops automatically. 

notes

 Eye tracking also stops when the test you designed in Tobii Pro 
Studio ends before you pressed the Stop observation button in The 
Observer XT. 

 If the computer with the Tobii Pro software is restarted, you must 
restart The Observer XT as well. Otherwise starting acquisition 
with the Tobii Pro software will not work. 

 If the computers with The Observer XT and the Tobii Pro software 
are restarted, it may take some time before the Tobii Pro plugin 
starts when you create the first observation. If you start an 
observation in The Observer XT before the plugin is fully running, 
acquisition with the Tobii Pro software does not start. If you notice 
this, create and start a second observation. Acquisition with the 
Tobii Pro software will now start. 

more information

For more information on how to design a test in Tobii Pro Studio, see 
the Tobii Pro Studio user manual.
Record with Tobii Pro Studio 25
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7 Import Non-AOI data into The 
Observer XT

aim

To import the following data into The Observer XT:

 Fixation data.

 Stimulus data.

 Mouse click data.

 Key press data.

 Recording type data (for Tobii Pro Lab only).

prerequisite

You carried out an observation in The Observer XT and simultaneously 
acquired eye tracking data with the Tobii Pro software. 

procedure

1. Export the data from Tobii Pro Lab (page 26) or Tobii Pro Studio 
(page 27).

2. Import the data into The Observer XT (page 29).

export the data from tobii pro lab

1. Open the project and click on Data export on the toolbar. 
Import Non-AOI data into The Observer XT



2. In the Settings pane on the right, select the recording to export. 

important  Select a single recording. Export each recording 
individually. Give each file a different name so that it does not 
overwrite the previously exported one. 

3. Under Select columns for the data export, select all columns.

important   Always select all columns. Otherwise the import profile 
won’t recognize the columns to import.

4. Click on Export. 

export data from tobii pro studio

1. In Tobii Pro Studio, click the Data Export tab.

2. Click Select Data Set and choose the recordings to export. 

3. From the Output list on the toolbar select Individual files.
Import Non-AOI data into The Observer XT 27
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4. Click the Column Order button and then the Reset Defaults button. 
Next, click OK. This ensures that the import profile matches the 
columns of the exported data file.

5. In the Data Export tab, select all columns for the data export, from 
General data to Eye tracking data and validity codes.

important   Always select all columns, except [Variable Name] 
Value. Otherwise the import profile won’t recognize the columns to 
import.

6. Click the Export data button and choose where to save the export 
files.

7. Proceed with importing the data into The Observer XT (next page).
Import Non-AOI data into The Observer XT



import non-aoi data into the observer xt

You must use a specific import profile. You do not need to convert the 
non-AOI export data before import in The Observer XT. 

1. Copy the export files from the Tobii Pro software to The Observer 
XT computer.

2. In The Observer XT, open the observation in which you want to 
import the eye tracking data. Click the Import data button on the 
toolbar.

Select Import observational data. The Import Observational Data 
window opens.

3. From the Files of type list, select the import profile you require.
- For Tobii Pro Lab fixation data: Tobii Pro Lab 1.98 Fixation Data 

(*.tsv).
- For Tobii Pro Lab stimulus data: Tobii Pro Lab 1.98 Stimulus Data 

(*.tsv).
- For Tobii Pro Lab key presses and mouse clicks: Tobii Pro Lab 1.98 

Keyboard and Mouse event Data (*.tsv).
- To exclude calibration from the observation (Tobii Pro Lab only): 

Tobii Pro Lab 1.98 Recording type (*.tsv).  
See To exclude the calibration from Tobii Pro Lab data on page 30 
for more information. 

- For Tobii Pro Studio fixation data: Tobii Studio 3.3-3.4 Fixation 
Data (*.tsv).

- For Tobii Pro Studio stimulus data: Tobii Studio 3.3-3.4 Stimulus 
Data (*.tsv).

- For Tobii Pro Studio mouse clicks: Tobii Studio 3.3-3.4 Mouse Click 
Data (*.tsv).

- For Tobii Pro Studio key presses: Tobii Studio 3.3-3.4 Key Press 
Data (*.tsv).

4. Under Treat new Behaviors as, select Point events.

5. Browse to the location on your computer where you stored the data 
file. Select the appropriate file and click Open.
Import Non-AOI data into The Observer XT 29
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6. If this is the first file you import into the project, you will be asked 
whether you want to import new coding scheme elements. Click 
Yes.

7. The data are imported into The Observer XT as a new event log in the 
current observation.

To exclude the calibration from Tobii Pro Lab data

Tobii Pro Lab, by default, adds a calibration to the Timeline. This 
calibration is included in the export file. For further analysis of the eye 
tracking data, you may want to exclude the calibration. To do so:

1. Import the Tobii data, following the procedure above. In step 3 
choose Tobii Pro Lab Recording Events (*.tsv) from the Files of type 
list.

2. Choose Analyze > Select Data > New Data Profile. Give the profile a 
name and click OK. 

3. Under Select intervals click on the box next to By Manual Selection. 

4. Under Interval Start Criteria choose Observational Data. 

5. From the Behaviors list, choose Eye tracker calibration end. Leave 
the rest of the fields at their default values. The window now looks 
like this:
Import Non-AOI data into The Observer XT



You now created an interval from the end of the calibration till the end 
of the recording. When you select this data profile, the data during 
calibration are excluded from visualization and analysis. 
Import Non-AOI data into The Observer XT 31
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notes

 For the first file you import into the project, you will be asked 
whether you want to import new coding scheme elements. Click 
Yes.

 Data from each import profile are imported as point events in a 
separate behavior group of type “Start-Stop”.

 Note that fixations and saccades are imported as point events, that 
is, events with no duration. If you are interested in calculating 
fixation duration, follow the same procedure as in Import AOI data 
into The Observer XT on page 37.

 If you want to analyze the behavior of the subject while a specific 
stimulus was presented, in the Data profile choose Select interval - 
By manual selection. For both Interval Start Criteria and Interval 
Stop Criteria, choose Observational data and then select the same 
stimulus element from the behavior list.

Next, insert the Intervals box in the Data profile.
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Check in the Visualization that the interval is selected for analysis 
that corresponds to the time between the start of the stimulus and 
the end of the stimulus (white area):

When you have two or more instances of the same stimulus, under 
Interval Stop Criteria select the following:

Various intervals will be defined:
- From start of first stimulus to end of first stimulus.
- From end of first stimulus to start of second stimulus. Ignore this 

result in the statistics table.
- From start of second stimulus to end of second stimulus.
- etc. 
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8 Import gaze replay video into The 
Observer XT

aim

To import the video with the gaze overlay into The Observer XT.

tip  If you have MediaRecorder and Tobii Pro Studio, you can record the 
screen of the Tobii Pro Studio computer (set Tobii Pro Studio to Remote 
Live Viewing) and import it automatically in the observation. This way 
you do not need to import video manually. In the Observer PC, add an 
exception to Windows Firewall to the application Tobii Studio Remote 
Viewer.

prerequisite

You carried out an observation in The Observer XT and simultaneously 
acquired eye tracking data with Tobii Pro software. 

procedure

Carry out the following steps:

1. Export the gaze replay video from Tobii Pro Lab (page 34) or Tobii 
Pro Studio (page 36).

2. Import the gaze replay video into The Observer XT, see page 36.

export gaze replay video from tobii pro lab

1. Open the project and click on the Recordings button on the toolbar 
on the left. 
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2. Double-click the recording from which you want to export the gaze 
replay video. 

3. On the left-hand side of the timeline you find two small yellow 
markers. Click-and -hold the right-hand one and drag it to the end of 
the video. This way the entire gaze replay video is selected for 
export.

4. Right-click the yellow bar and choose Export video clip. 

5. Browse to the location to store the video file, name the file and click 
Save. 
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export gaze replay video from tobii pro 
studio

1. Click the Replay tab, then click the Export Movie button.

2. In the window that appears, choose the options you require.

optional  As Output folder, choose the folder shared with The 
Observer XT computer.

3. Click OK. 

import the gaze replay video into the 
observer xt

1. In the Observer XT, open the observation you want to import the 
video to.

2. Choose Observe > Video > Open in Current Observation, or click the 
import video button on the toolbar.

3. Choose the video file exported from the Tobii Pro software and click 
Open.
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9 Import AOI data into The Observer 
XT

aim

To import Area of Interest data into The Observer XT.

prerequisites

 You defined Areas of Interest in the Tobii Pro software. 

 You have Tobii Pro Lab 1.98 or Tobii Pro Studio 3.4. Contact the 
Noldus help desk if you have another version of Tobii Pro software.

 You have the file Tobii Studio File Converter 3.0 Setup.exe provided 
by Noldus Information Technology. 

procedure

Carry out the following steps.

1. Export the eye tracking data from Tobii Pro Lab (page 26) or Tobii 
Pro Studio (page 36). For AOI data, it is not needed to export all 
columns, as long as all columns described in variables to export - 
tobii pro studio on page 38 are exported. 

2. Convert the export file, see page 39.

3. Import the converted file into The Observer XT, see page 43.

variables to export - tobii pro lab

Under General

 Project name: The name of the project in Tobii Pro Lab.

 Recording name: The ID of the recording.
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 Recording Date: The start date of the recording.

 Recording Start time. The start time of the recording.

  Recording Timestamp: The time stamp of a sample point from the 
start of the recording (set to zero).

Under Gaze events:

 Gaze Event Duration: The duration of a fixation.

 AOI hit: The name of the Area of Interest.

variables to export - tobii pro studio

Under General data:

 StudioProjectName: The name of the project in Tobii Pro Studio.

 RecordingName: The ID of the recording.

 RecordingDate: The start date of the recording.

Under Timestamp data:

 RecordingTimestamp: The time stamp of a sample point from the 
start of the recording (set to zero).

 LocalTimeStamp: The local time stamp of a sample point.

Under Gaze event data and AOI activity information:

 GazeEventDuration: The duration of a fixation.

 AOI[Name of AOI]Hit: The name of the Area of Interest.

Tips

 In Tobii Pro Studio, it is possible to save the current selection of 
variables as “AOI data”, so you can quickly open the same selection 
when necessary (Load Settings). To do so, click the Save Settings 
button.
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 To use the same data file also to import non-AOI data, for Tobii Pro 
Lab select all variables, or for Tobii Pro Studio select all variables 
except [Variable Name]Value. You can use that file in the 
procedures on page 26.

Structure of the export file

In the export file, each area of interest is represented by a column (see 
the last column in the example below). For each sample point, the cell 
contains 1 (fixation in that AOI) or 0 (no fixation).

convert the aoi data

Why convert AOI data?

To be able to import the AIO data into The Observer XT, the export file 
must be converted into a format that can be read by The Observer XT. 

note

To import non-AOI data, such as fixations, mouse clicks, key presses and 
stimulus data, see page 26.
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Install Noldus Tobii Studio File Converter

1. Close Tobii Pro Lab or Tobii Pro Studio.

2. Copy the file Tobii Studio File Converter 3.0 Setup.exe to the PC 
where you have stored the Tobii Pro export files.

3. Double-click Tobii Studio File Converter 3.0 Setup.exe and follow 
the instructions on the screen.

4. When installation is completed, click Close.

By default, the Tobii Studio File Converter is installed on C:\Program 
Files (x86)\Noldus\Noldus Tobii Studio File Converter.

Convert AOI data into The Observer XT format

1. In the Apps screen, under Noldus click Noldus Tobii Studio File 
Converter.

2. Next to Tobii Studio source file, click Browse, select one or more files 
exported from the Tobii Pro software and click Open. 

To select multiple TSV files, click Browse, click the TSV file names 
while holding the Ctrl key down, and click Open. A message 
confirms that multiple files are selected.

3. Next to The Observer XT destination folder, click Browse and select 
the folder where you want to store your converted files.
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4. Click Convert.

5. A message appears in the window “Conversion is ready”. Click Exit to 
close the window.

The converted export file

To check the contents of the converted export file (*.txt), right-click it 
and select Open with Notepad. Do not open it in a word processor such 
as Microsoft Word. The file should look like this. 

The first line contains the value of the variable RecordingDate and the 
first value of Recording Start time (Tobii Pro Lab) or LocalTimeStamp 
(Tobii Pro Studio) in the recording. If the variables are not in the original 
export file, they do not appear in this line. The second line contains 0 
(zero). This line is added automatically by Noldus Tobii Studio File 
Converter. 

The columns contain the following information:

 Time from the recording start time (in ms).
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 Name of the area of interest.

 Event type (start/stop).

 File name of the stimulus (optional). 

To import the file into The Observer XT, see page 43.

Notes

 The name of the converted file is Observer-[StudioProjectName] 
[RecordingDate] [RecordingName].txt.

If Studio Project Name and Recording Date are not exported from 
the Tobii Pro software, the converted file name is Observer-
[Recording Name].txt.

 If the Tobii Pro export file contains more recordings, each recording 
is converted to a separate text file.

 If the Tobii export file does not contain one of the required columns, 
when trying to convert this file the message appears:

Click Yes to continue converting (if you have selected multiple files), 
otherwise click No. Re-export the file with the correct columns and 
convert it again. 

 The Tobii export files may also contain other columns like 
ParticipantName or GazeEventType, but they will not be converted.

 The converted file ends when the last AOI hit ends. The length of 
the converted file may therefore be shorter than the original 
recording. 
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import aoi data into the observer xt

IMPORTANT  Make sure that you have converted the export files with 
Noldus Tobii Studio File Converter (page 39).

To import the data into The Observer XT

1. In The Observer XT, in the Project Explorer, open the observation in 
which you want to import the eye tracking data. Click the Import 
data button on the toolbar.

2. Select Import observational data.

3. In the Import Observational Data window, from the Files of type list, 
select Tobii 3.x AOI Data (*.txt).

4. Browse to the location where you stored the converted files. Select 
the appropriate file and click Open.

Notes

 To import multiple recording files in the same observation, click 
each converted file name while holding the Ctrl key down.
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 The files are imported as separate event logs in the same 
observation.

 When visualizing multiple recordings, they appear in separate 
charts, one for each recording.

 If this is the first file you import into the project, you will be asked 
whether you want to import new coding scheme elements. Click 
Yes.
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10 Synchronization

how to determine the delay between the 
observer xt and tobii pro software

Data synchronization

The system described in this note makes it possible to start recording in 
Tobii Pro software the moment you start an observation in The 
Observer XT. The eye tracking data are aligned with the observational 
data scored manually. However, there may be a delay between the start 
of the observation and the start of recording in the Tobii Pro software. 
The delay may be caused, among other things, by delays in the network 
communication. As a result, there may be a mismatch between eye 
tracking data and observational data. 

To measure the delay

1. Define in your coding scheme a Point event labeled, for example, 
sync.

2. Start an observation as usual. 

3. Ask the test participant to perform an action that could be seen on 
the screen (for example, typing in a letter in a web field or the 
Windows Notepad). 

4. The very moment he/she performs that action, score the sync event. 

5. Import the video made by the Tobii Pro software into The Observer 
XT, and look when the letter appears on the screen. The difference in 
timing between that time and the time that you scored sync gives 
you the value of the delay. 

This method is less precise than the previous as it relies on the coder's 
reaction time.

To compensate for a delay

1. Take note of the value you measured with one of the two methods 
above.
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2. Open the observation and click the Offset button.

3. Click Numerical offset. 

4. Next to the name of the event log containing the eye tracking data, 
enter this delay. For example, if the delay was 0.5 s, then enter 
00:00.500.

For more information, in The Observer XT Help see External Data > 
Import External Data > Manual Synchronization.
Synchronization



11 Firewall settings

aim

When N-Linx Agent is installed, it enables the necessary 
communication ports. Follow this section in case communication is for 
some reason blocked by Windows Firewall.

prerequisites

 The Tobii Pro software and The Observer XT run on different 
computers, or N-Linx Server runs on a third computer other than 
The Observer XT computer and the computer with Tobii Pro 
software. If that is not the case, skip this section. 

 The computers must be in the same network.

procedure

important  Do the following in all computers: the computer with Tobii 
Pro Studio software, the Observer XT computer, and the computer 
where N-Linx Server is installed (if this is different from the computers 
where The Observer XT and the Tobii Pro software are installed).

1. Open the Windows Control Panel and choose Windows Firewall.

2. On the left side of the window, click Advanced Settings.

3. In the pane on the left, click Inbound Rules and then in the Actions 
pane on the right click New Rule. 

4. In the window that opens, select Port and click Next.

5. Select TCP and Specific local ports. Next to that option enter 5672, 
then click Next.

6. Select Allow the connection and click Next.

7. Select to which network the rule applies and click Next.
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8. Give the rule a name, for example N-Linx connection and click Finish.

9. Check in the Inbound Rules list that this rule is set to Enabled.

10.Click Outbound Rules and click New Rule in the Actions pane. Repeat 
steps 4 to 9 for the outbound rule.

11. Close all Control panel windows.

check connection in n-linx agent

1. At the bottom-right corner of the screen of the computer with Tobii 
Pro software, click the arrow icon and in the system tray double-
click the N-Linx Agent icon.

2. Next to N-Linx Server Address make sure that the IP address of the 
Observer XT computer is specified. This IP address must be fixed.

note  If The Observer XT and N-Linx Server are installed on the 
same computer, enter localhost.

tip  You can also enter the Computer name of the computer where 
N-Linx Server is installed, instead of its IP address. On the computer 
where N-Linx Server is installed, open the Control Panel and choose 
System. Locate Computer name (not Full Computer name).

3. Click Connect. If connection is established, the message at the 
bottom of the N-Linx Agent window says Connected.

4. Click the Close button to close the N-Linx Agent window.
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12 General notes

the observer xt

Independent Variables

If the Independent Variables list appears when you press the Start 
Observation button, the actual observation (and therefore eye tracking 
by Tobii Pro Studio) starts when you click OK in the Enter Independent 
Variables window.

You can choose when the Enter Independent Variables window 
appears. For details, see Set up your Project > Project Settings in The 
Observer XT Help.

For more information on recording data in The Observer XT, see Carry 
out an Observation in The Observer XT Help.

n-linx agent 

On the Tobii Pro Studio computer, you can check the status of N-Linx 
Agent. Click the arrow icon on the system tray, then double-click the N-
Linx Agent icon.

The N-Linx Agent window shows the status of Tobii Pro and The 
Observer XT. 
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 The Observer XT is visible and Online when the program is open.

 Tobii Pro is Offline when it is installed, but not active. This is the 
case immediately after installation of N-Linx Agent and after the 
computer is restarted.

 After creating an observation in The Observer XT, the status of Tobii 
Pro becomes Online.

 Online means that the Tobii Pro plugin is started and therefore 
available for communication. Once the Tobii Pro plugin is started, it 
remains running until the PC is shut down.

eye tracking

To carry out a new recording with the same participant

Tobii Pro Studio: Start a new recording on the Tobii Pro Studio 
computer. Open the tab Use Existing Participant. Select the participant 
and click Continue. Then repeat the procedure from step 13 on page 24.

Tobii Pro Lab: Open the Record tab and select the participant in the 
Participant pane at the bottom. Then repeat the procedure from step 9 
on page 21.

To repeat calibration

Select the points to recalibrate and click Recalibrate (n. points). 
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If the calibration continues to be unsatisfactory, Tobii Pro Studio has 
the option to look into the calibration in more detail. To do so, click 
Check Calibration. Nine points appear on the screen of the test 
participant, with the gaze represented as a circle. Move the chair up 
and down or backwards and forwards until the circle is around the dot 
the participant looks at. Make sure the gaze is detected in the correct 
position for each calibration point. When done, let the participant press 
the Esc key. Tobii Pro Lab does not have this functionality. 

To view the fixations live 

Do one of the following:

 Connect the Tobii Pro system to two monitors. Place one of the two 
monitors in the observation room. In Tobii Pro Studio, click the 
Setup icon and choose Show Live Viewer, and select that monitor.

 If you have the Enterprise version of Tobii Pro Studio, this version 
includes a remote viewer application. Install this on the Observer 
computer to view the fixations live. You can also use this program 
to control Tobii Pro Studio, for example start a new recording, and 
do the calibration.

test leader display

Windows font size

 To make sure that the gaze points are correctly positioned when 
reviewing the test, set the Windows font size on the stimulus 
monitor to 100%. In the Search field of the start screen, type 
“display” and click Change display settings. Under Scale and layout, 
choose 100% from the list Make text and other items larger or 
smaller.
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Multiple monitors

When using a dual screen setup, set the same resolution on both 
screens.
General notes
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